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Lucity - Basic Desktop Functionality 
In this workbook, we will introduce you to the basic layout and functionality of the Lucity™ desktop 
system.  This includes menus, form layout, fields, toolbars, adding/editing/deleting records, finding 
records and filtering records, attaching documents, and running reports.  We will also introduce you to 
Asset and Work Management topics. 
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Introduction to Asset Management 
The Lucity™ suite offers you a comprehensive solution for Asset Management.  Our user-friendly 
inventory and inspection modules are all structured around the basic functions discussed in the 
following pages.  These modules allow you to manage your asset inventory, assess the condition of your 
assets, and determine your maintenance needs.  Our modules have been created specifically for Public 
Works Departments and allow you to manage your water, storm, and sewer assets, transportation 
system, fleet, plant/equipment, facilities, trees, and parks. 

System Inventory 
Each solution provides inventory modules for comprehensive data capture of your assets and their 
components.  The inventory modules consolidate asset information into a single database.  You can 
easily retrieve and analyze this data using the built-in filtering and reporting capabilities.  Additionally, 
each solution provides functionality designed specifically for the assets you are managing.  For 
example, the Pavement module provides you with maintenance forecasting and budget forecasting 
capabilities, whereas the Tree module allows you to create a library of scientific information about the 
trees in your system as well as determine the value of each tree using two distinct valuation methods. 

Field Inspection 
Most inventory modules have corresponding inspection modules that allow you to manage your system’s 
condition assessment data.  These modules are fully integrated.  Physical data in the inventory tables 
link directly to the inspection data.  When you correct discrepancies in the inspection modules, the 
inventory data automatically adjusts.  By compiling and analyzing inspection data, you can detect 
trends in system performance and organize rehabilitation plans for maximum efficiency. 

Introduction to Work Management 
The Lucity™ suite also offers you a comprehensive solution for Work Management.  The Lucity Work 
suite of modules allows you to track customer requests, create work orders, establish a preventative 
maintenance plan, set priorities, provide timetables, track system rehabilitation, manage work 
projects, and perform budget forecasting. 

Work Orders 
The Work Orders module allows you to schedule and track work tasks, personnel, equipment, and 
material usage.  Three versions of work orders are offered on the desktop:  Standard, Lite, and Daily 
Work.  All three modules integrate with the same data set.  The Standard module is the most 
comprehensive of the three, offering additional functions such as costing, billing, and tracking.  Work 
Order Lite contains only the basic functions of the Work Order Standard module.  This allows for quick 
and easy data entry.  The Daily Work module is the most basic of the three, designed for quick data 
entry without your fingers ever having to leave the keyboard. 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________ 
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Menus 
The menu bar will help you navigate through the Lucity™ desktop suite.  After logging into the system, 
you’ll see a menu bar at the top of the screen: 

 

 

The menu items correspond to individual groupings in the software, system functions, and the help 
guide.  Each main menu item contains a drop down menu listing each available module.  For example, 
under the Work main menu item, you can see a list of all modules that pertain to performing Work. 

 

 

Although the menu bar contains all of the capabilities and programs offered by Lucity, only those 
purchased or that have been granted security permissions will be accessible.  If you click on a program 
that you have not purchased or have not been granted security permissions to access, a drop-down 
menu will appear; however, the menu items will be disabled (grayed out). 

Form Layout 
Each application in the Lucity™ desktop suite has a window designed specifically for the information 
recorded in that module.  Although each module has unique features, the components that make up 
each window are the same.  This helps make the desktop easy to use.  The basic components of each 
window are the Module Toolbar, Header Data, Fields, Field Captions, Attribute Tabs, and the Status 
Bar.  We’ll discuss each of these components in the following pages using the Work Orders module as a 
guide. 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Module Toolbar 
At the top of each window, you’ll see a Module Toolbar.  

 

 

This toolbar contains buttons that perform or access a variety of standard functions.  Place your cursor 
over an icon to see the name/function of that particular toolbar button.  For example, if you place 
your cursor over the icon that resembles a printer, the words “Print Module Window” appear.  

 

Since each module’s toolbar may vary, there may be 
instances where buttons appear to be “grayed out”.  
These buttons are inaccessible for that module; nothing 
will happen when they are clicked.  
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Toolbar Buttons 

These buttons will appear when they are applicable in a given module. 

Button Name Description 

 Resize Resizes the module window. 

 
Print Module 
Window 

Captures the screen image and sends it to your designated printer. 

 
Locate Quickly locates specific records. 

 
Browse 

Browses records, produces quick custom reports, and exports 
information. 

 
Filter Opens the Filter window. 

 
Reports 

Views, prints, or adds/deletes reports to or from the list of pre-
defined reports. 

 Open Document 
Views a list of documents, videos, and images attached to the 
record. 

 
Document Control 

Adds or deletes documents, videos, and images to or from the 
record. 

 Save Saves your changes. 

 
Cancel Cancels any changes you have made since the last save. 

 
Add Record Adds a new record to the module. 

 Edit Edits the current record. 

 
Delete Deletes the current record. 

 
First, Previous, 
Next, Last 

Navigates through the data set. 

 
Go To Views a specific record number. 

 
Refresh 

Re-queries the data set and returns your screen to the first record in 
the filtered set (i.e., it runs the filter again). 

 
Relationship Displays other modules related to the current record. 

 
Subsets Creates and saves a set of filtered records. 

 
Work Order Generates a Work Order for the current record. 

 
Work Request Generates a Work Request for the current record. 

 
PM/Template Generates a PM/Template for the current record. 

 
Toolkit Opens the Toolkit dialog box.   

 
Show In Map Opens the map, zooms in, and highlights the selected feature. 

 
Recalculate Updates all calculations in the module. 



Basic Desktop Functionality  7 

 

Custom Library 
Function 

Only appears in the Work Request module, and only works for 
those clients for which it was installed. Used in the "Search for 
Customer" process in Requests when accessing a third-party table 
containing the requestor or requestor address. 

 Help Opens the Lucity Help Guide to the appropriate topic chapter. 

 
Close Closes the module. 

 

Adding, Editing, and Deleting Records 
The steps for adding a new record, editing the current record, or deleting a record are the same 
throughout the modules: 

 

To Add a New Record: 

1. Click  on the module toolbar to add a record.  You are now in Add Mode. 

2. Enter any Header data or required data. 

3. Enter any additional information in the Attribute Tabs. 

4. Click  to save the record. 

 

To Edit the Current Record: 

1. Click  on the module toolbar to edit the current record.  You are now in Edit Mode. 

2. Make the necessary changes. 

3. Click  to save your changes. 

4. Click  to exit Edit Mode or cancel your changes prior to a save.   

 

To Delete a Record: 

1. Locate the record you wish to delete. 

2. Click  to delete the record. 

3. You will receive a prompt asking you to confirm the deletion.  Take care when deleting records 
as this action cannot be undone. 

 

Your security settings may limit who can add, edit, and delete records. 
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Header Data 
At the top of the module window you will see header data.  This is visible regardless of which tab is 
displayed below.  It is important to enter data in the header for each new record because this 
information defines or distinguishes each record using unique IDs. 

 

 

Header data varies with each module.  In most modules the header data consists of an ID number or 
some other number that identifies the asset represented in that record.  Many modules have fields 
required by the system in the header, meaning a record cannot be saved until data is entered in these 
fields.  You will receive an error message if you attempt to save the record without that required 
information.   

For example, here’s a message that will appear in Work Orders if the fields required by the system 
aren’t filled out upon saving: 

 

If a user has set a field to required, the field will display in blue.   
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Tabs 
Each module has various tabs to organize and store similar types of data.  You can see on the screen 
below that the Work Orders module has tabs for WO (Work Order attribute data), Location, Assets, 
List/Events, Tasks/Resources, Routing, Costs, Billing, Related, Requests/Tracking, Links, Custom1, 
Custom2, Custom3, Custom4, and Comments.  Although tabs vary by module, each module typically has 
Custom and Comments tabs.  To navigate through the record, click on the tab names.  The display will 
change accordingly. 

 

 

Status Bar 
The status bar, located at the bottom of the module window, performs a variety of functions.  The 
status bar allows you to see whether the current record is in View Mode, Add Mode, or Edit Mode.  
Another piece of information shown is the record number you are viewing out of how many records are 
in the current filterset.   

When you add new records on the desktop, a filter is automatically created with just your new records.  
When you are creating new records, you may not want to see all of the existing records.  So, the status 
bar will default to a count of the records created by you on the current day.  The example below shows 
that when you are in Add mode and are in the middle of adding a new Work Order, the status bar 
shows the count of “Record 0 of 4”.  The current record hasn’t yet been saved while you are in Add 
mode, so the count says you are on Record 0 out of 4 records created by you on the that day:   



Basic Desktop Functionality  10 

 

After the record is saved, the record count on the status bar then changes to Record 5 of 5, indicating 
that the new record was added to your filterset of new records added that day: 

 

 

To view all existing Work Orders including our newly created Work Order, click the Filter button drop 

down list  and select Reset Filter.  The record count will now display the total number of Work 
Orders: 

 

On the desktop, newly added records generally get put on the end of the existing data.  When you 
reset the filter, you will be taken back to the first record. 

The status bar may also display any messages regarding available Hot Keys or other special functions.  
The status bar above in Add Mode tells you that when your cursor us in the Problem field, by pressing 
the <F9> hot key, a pop-up list of choices will appear or by pressing the <F7> key, a filtered pop-up list 
will appear.  Finally, the status bar alerts you when the system is busy performing another function.  In 
these examples, the status bar reads “Ready”, meaning the system is not performing any other 
function at this time. 
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Grids 
Each module on the desktop may have one or more grids that appear throughout the tabs.  Many of 
these grids indicate special relationships.  Several grids also contain actions that can be performed on 
the data inside the grids. 

Grid Relationships 
The grids inside a module can indicate special relationships.  In Work Orders, there is a grid that 
displays the Assets that are included in the Work Order.  The assets are considered “children” of the 
current Work Order.  The Work Order would be considered a “parent” of the assets.  Some of the grids 
also contain “linked” records that are related to the current record through special relationships.   

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Occasionally, a grid inside of a module can contain parent records to a child grid beneath it.  Clicking 
on one of the parent records will display only its children in the grid beneath it.  For example, the 
Work Order Tasks are a “parent” of the Resources and the Resources are considered “children” of the 
WO Tasks.  So, clicking on the task parent will only show the resources that are associated with that 
task: 

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Grid Functions 

In addition, the records in the grids may have actions that can be completed on them.  To see if there 
are actions that can be performed, highlight the record in the grid and click the right mouse button.  
Any functions that are available for that record will appear.  These are also known as “Right-Click” or 
“Right-Mouse” functions.  For example, the “Right-Click” functions for the “Hydrant Valve 
Maintenance” task are displayed here: 

 

 

Fields and Field Captions 
Each record contains various field types and field captions.  Fields are the locations on the window 
where data is entered.  Each field is preceded by a field caption button. 

Field captions define what information should be entered into a particular field.  For example, the first 
field caption below is titled “Priority”.  A priority of 1 – High has been entered in the corresponding 
field. 
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All fields have a field definition window and a field 
properties window.  You need to be in View Mode in order 
to see the Field Properties, Field Caption, and Global Edit 
functions.  You can access these functions by placing your 
cursor over a field and using Ctrl + Right Click. 

These windows allow you to view or change the field 
definition, change the decimal point placeholders in a 
numeric field, make field entry required or restricted, etc.. 
Some fields are editable and others are static (meaning you cannot modify them).  Editable fields have 
a white background while static fields have a gray background.  A few special fields have a Global Edit 
option.  This option allows you to mass-populate a field in your filtered record set without having to 
update each record individually. 

Field Instructions 
Some fields may have special function keys that are applicable to that field.  These functions enable a 
user to perform a task more quickly.  A short instruction would display on the status bar when the 
cursor is inside the field.  For example, in the Work Order Task module, there are instructions for the 
Task field.  If a user would like to filter the list, they could first enter the characters to filter by and 
click F7.  In the example below, the Task list is filtered by those that start with ‘WT’: 

 

Here are some examples of fields that use the F5 key to copy a value from one field to another: 

 In Requests, from the Phone field to Home Phone, Phone 1 or 2, or Work Phone. 

 In Work Orders, from the Start Date to the End Date. 

 In Work Orders, from the Total Cost to the Billing Amount. 



Basic Desktop Functionality  15 

Field Types 
There are different types of fields available for data entry.  For example, some fields require 
numerical data while others require text.  A brief definition and example of each field type is listed in 
the table below. 

Code-Description or “Picklist” 
Fields 

 

These fields require you to enter a code in the first 
box. The code description will then appear in the 
grayed-out box. For example, a code might be 
1=High, 2=Medium, 3=Low, etc. The number 1 would 
go in the first field and the description “High” 
would automatically appear in the second field. The 
codes and descriptions are created and then 
accessed through a picklist. 

 

Numeric Fields 

 

Numeric fields only allow a number to be entered. 
Depending on the field, the numbers may or may 
not contain decimals.  Most numeric fields are right-
justified. 

 

Text Fields 

 

Text fields allow both letters and numbers to be 
entered.  Most text fields are left-justified. 

Logical (checkbox) Fields 

 

Logical fields allow you to enter a checkmark in the 
box if you wish to select that field.  

Date Fields 

 

Date fields can be manually or automatically 
entered. To manually enter a date, use the 
mm/dd/yyyy format. Use the arrow keys in place of 
the slash. To automatically enter the current date, 
hit the space bar while your cursor is in the field. 
You can also use the drop-down menu to select the 
date from a pop-up calendar. You can then use the 
arrow keys at the top of the calendar to select a 
different month or year. 

Time Fields 

 

Time fields can be manually or automatically 
entered. To manually enter a time, use the arrow 
keys in place of the colon. To automatically enter 
the current time, hit the space bar. To identify AM 
or PM, enter an “A” or “P” after the time or use the 
up or down arrow keys on your keyboard. 

Comment Fields Comment fields allow users to enter multiple lines 
of text in paragraph form. These comment fields 
have copy/paste abilities and carriage returns using 
Ctrl + Enter. 
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Tools 

Locate 
The locate feature allows you to quickly find specific records within the current record set.  
The following example is from the Work Orders module; however these same steps apply in 
all other modules.  You can use this feature if you know specific identification information 

about the record you are looking for, or if you’d like to search through a list of the records available. 

To access the locate feature, click  on the module toolbar. 

 

Your search is organized by the fields at the top of the window.  Click on the column header for the 
field you want to search in.  The selected header text will be shown in red italics and the records in 
the dialog will be sorted by that field.  In the example above, the “Work Order #” header is selected. 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________ 
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You can search for a record by scrolling through the list shown or by using a dynamic search.  In a 
dynamic search you will use the text box at the top of the window to enter the information you are 
looking for.  In this example, we’ve entered Work Order #17-000020 and the system has found the 
corresponding record.  The record found by the system will be highlighted in red.   

 

 

 

The system will also search for partial text.  In the example above, when “17” is typed, the red line 
will jump to the first record beginning with “17”.  As you continue typing, the highlighted line will 
move to match your search item.  This function is performed automatically. 

Once you have found the record you are searching for, click , double click, or hit <Enter> on 
the keyboard.  The module will open to the highlighted record. 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Filtering Records 
A filter helps you narrow your search for a specific record or set of records.  For instance, you 
may be trying to manage your Work Orders, but find that you have to sort through other 
people’s records as well.  A Filter will allow you to work with only your desired records. 

Once you’re comfortable with filtering, you’ll be able to use filters to extract a great deal of 
specialized information out of the system.  You can find assets that are costing you the most in 
maintenance, do cost and trend analyses, and much more. 

There are three ways to open the filter window: 

1. When you open a module for the first time you will be prompted to open or define a filter 
before any records are displayed. 

2. After a module is already opened, you can select or create a filter by clicking the filter 

button in the toolbar . 

3. In the Filter drop-down list , you can select the “Filter” option.   

Using the Filter Window 

The filter window has several tabs with different functions. 

Filter 

The “Filter” option is the first tab in the Filter window.  This tab contains a list of saved filters 

and will default to showing only your filters.  If this is your first time using the module, no filters 

will be saved under your ID but you can search for all filters by removing the check in the “My 

Filters Only” box. 
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Sort 

The “Sort” option is the second tab on the Filter window.  You can set up a sort order of your filtered 
data in ascending or descending order based on the field(s) you select.  This Sort function is not a filter 
but rather affects the display of the filtered data.  This step is optional so it may be skipped.   

 

 
 
To use the sort function, complete the following steps: 

1. Highlight a field in the “Selectable” list.  You can use the selection buttons at the bottom of 
this list to change the order in which the fields appear.  “Standard Order” reflects the order in 
which the fields appear in the module itself.  If you’d prefer, you can change it to 
“Alphabetical” order.  

2. Click the right arrow  and the field appears in the “Selected” list.  You can select as many 

fields as you like from the list.  Use   to remove an item from the list. 
3. Click the “Ascending” or “Descending” buttons under the “Selected” list to indicate how you 

want the records sorted. 
4. Click “Reset” to clear all “Selected” fields and start over. 
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Filter Tabs 

The remaining tabs in the Filter window (Pg. 3, Pg. 4, Address, etc.) contain all of the filterable fields.  
You will use these tabs to set up your filter criteria. 

 

 

 

When you move through the tabs you’ll see that the fields appear in the same order as they would in 

the Work Order module (or whatever module you are using).  The right and left arrows  at the 
top-right of the screen allow you to move through the tabs and see more filter options. 

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Day-to-Day Work Order Filters 

To help you better understand how to use filters in your daily work, we’ll go over some specific 
examples.  Supervisors are responsible for managing their own work.  That means generating Work 
Orders from public Work Requests, creating Work Orders for new jobs, looking through Work Orders on 
a daily basis to schedule and manage work, editing Work Orders to keep them current, and closing 
Work Orders when the job is completed.  All Work Orders in the Lucity system are shared, so you can 
view other supervisor’s Work Orders as well as your own.  Work Orders that are completed and closed 
are not erased from the system. Over time, you’ll have more and more Work Orders. 
In order to manage the records, you can use a filter to see only the records currently assigned to you.  
The following example shows you how to set a filter with a supervisor’s name. 

Filter with ‘Equals’ (Supervisor Name) 

 

Since we want work orders with a specific supervisor’s name, we’ll set up a filter for Sean Ray.  To find 
his Work Orders, we’ll filter the records so that “Supervisor equals Sean Ray”. 
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Start by finding the Supervisor Text field.  The Work Order filter has this field on Pg. 5.  Note that 
‘Supervisor’ refers to the employee’s CODE, while ‘Supervisor Text’ refers to the NAME.  This is the 
case for all Code/Type fields (white + grey field).  Set the drop down list next to Supervisor Text to 
‘equal’.  When you do, the Supervisors will be listed in the box to the right.  Use the up and down 
arrow to scroll to the entry you want (or, you can click on one entry, hit the first letter, “S”, and you’ll 
jump to the “S’s” in the list). 

Find your choice and click it.  It will be highlighted in blue.  This reads like a formula:  Supervisor Text 
= Sean Ray. 

Count Records 

  Click the Count Records button to get a count on the records that will be filtered out.  
Here we can see that 97 (out of the total 5540) Work Order records have Sean Ray named as 
Supervisor.  

 

Go to Records 

  Now click “Go” on the filter screen and the 97 Work Orders with Sean Ray named as a 
supervisor will be shown.  You can see the record count at the bottom of the screen (in the status bar). 

 

To see a list of the records, use the Locate Button .  You’ll see the filtered record set only (the 97 
records found in your filter). 
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Filter with ‘In List’ (Statuses) 

Next, let’s filter out the old Work Orders that are completed or cancelled, leaving only current work 
for Supervisor Sean Ray.  You’ll need to filter out all the Statuses indicating the Work Order is finished.  
Return to your filter form and 
find Status Text on Pg. 3.  
Instead of ‘equal’, which 
allows it to be equal to only 
one value, select ‘in list’, 
which allows you to choose several matching values. 

Hold down the CTRL or SHIFT keys and click to highlight each status indicating a current Work Order.  
The filter statement you’re building reads something like this:  

“I want Work Orders where Status Text is in this list:  

 Missing Required Data 

 New Work Order 

 Scheduled       … etc…” 

 
Click ‘Count Records’ again - all open Work Orders for Supervisor Sean Ray.  Click ‘Go’ to open the 
records, and ‘Locate’ to see a list. 

Save the Filter 

Filters can be saved for use in the future.  To save a filter, select the “Save” button if it is the first 
time you have saved the filter or “Save As” button on the Filter screen.  The saved filters will appear 
on the filter window.  Filters created by the user currently logged into the desktop will also appear in 

the drop-down list next to the filter button .   

 

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Filter Display Options 

The selection buttons at the bottom of the “Saved Filters” list allow you to choose to display only your 
own saved filters and indicate whether or not a default filter will be used each time a module is 
opened.  Note:  Default filters are workstation specific. 

 

1. When you select the “Skip this Screen” option, the filter form will not appear each time the 
module is opened.  Instead, the system will open the module directly to the record set.  If 
needed, you can still open the filter from the module toolbar. 

2. When the “Load Default Filter” option is selected, the system runs the filter marked as default 
each time the module is opened.  The default filter will be listed at the bottom of the screen.   

3. To change the default filter, highlight a different filter name in the saved filters grid and click 
the Make Default button on the right-hand side of the filter screen. 

4. When the “Load All Records” option is selected, the system will display all records each time 
the module is opened.  

5. When the “My Filters Only” option is selected, the saved filters grid will display only the filters 
saved using your Lucity login ID.  If this option is not selected, all saved filters, including those 
saved by other Lucity users, will appear in the grid. 

Resetting a Filter 

After running a filter, you can reset the records in the module back to the full list by selecting “Reset 
Filter” located in the Filter drop-down list.   
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Advanced Filters 

If you find that one of our standard filters does not provide the necessary results, you can use an 
advanced filter.  Advanced filters are particularly useful if you want to query for null values or include 
‘or’ statements in your query.  In the following step-by-step examples, we’ll show you how to create 
some of the simplest forms of advanced filters.   

Keep in mind that for more advanced types of filters it’s very important that you have knowledge of 
SQL syntax to create your queries.  Also, you should know that the filter syntax differs depending on 
which database you are using (i.e., SQL Server or Oracle).  Finally, reports won’t run properly with 
advanced filters.  You’ll need to define the Report SQL in order to use advanced filters in your reports.  
For additional information on our advanced filters, please consult our Lucity help guide or talk to your 
database administrator for help writing SQL queries. 

 

Filtering for Null Values 

In our first example, we’ll show you how to create a filter for a null value.  In other words, we’ll show 
you how to filter for a blank field.  The easiest way to create this type of advanced filter is to start 
with a standard filter. 

1. First, select a field to filter on.  We’ll use the Cause field in Work Orders. 

2. Select ‘equal’ from the drop-down list.  Then, highlight any value in the next field.  It doesn’t 
matter which one you select as we’ll be deleting it in the next step. 

3. Click the Advanced button. 
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4. In the Advanced SQL window, delete the = sign and anything after it.  Here, we’ll delete the = 
sign and ‘BRC75’. 

 

 

5. Next, type IS NULL where you made the deletion.   

6. Click GO to see your filtered set.  This particular record set will contain any records where the 
Cause field is null (blank). 

 

 

 

Filtering Using ‘OR’ Statements 

Now, we’ll show you how to alter a standard filter to include an ‘or’ statement.  This is another kind of 
advanced filter that’s really quite simple to use.  For example, you may want to use this type of 
advanced filter to find all Work Orders where you are listed as either a Lead Worker or a Supervisor.  

  

1. On Pg. 5 of the filter screen, set the Supervisor Text and Lead Worker Text equal to the name 
of the person.  Here, we’ve selected Marian Schultz. 
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2. As the filter appears initially, it will return all records where both the supervisor AND lead 
worker are Marian Schultz.  Since we want to return records where she is listed in either 
capacity (not both), we’ll use an advanced filter.  Click the Advanced button. 

 

 

3. On the Advanced SQL tab, delete the word AND and type OR in its place.   

4. Add parentheses around the new query:  WKORDER  WHERE (WKORDER.WO_SUPR_TY = 

'Marion Schultz' OR WKORDER.WO_EMP_TY = 'Marion Schultz') 

 

5. You can then click the GO button to access the filtered set.  This filter will now return all 
records where Marion Schultz is listed as either the Supervisor OR the Lead Worker. 
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Filters for ‘In List” Numbers 

The final type of advanced filter that we’ll demonstrate is a filter for numbers in a list.  Remember, 
earlier in this workbook we discussed filters for ‘in list’ statuses.  That kind of filter allowed you to 
select multiple values from a pick list; however, certain fields in the filter form don’t provide pick 
lists.  These include fields like Work Order and Request Numbers.  To search for multiple Work Order 
Numbers in a list, complete the steps below: 

1. On Pg. 3 of the filter window, select ‘in list’ from the drop-down menu beside Work Order #. 

2. In the field to the right, type your first Work Order Number as it appears in the Work Orders 
module.  Then press the <Enter> key.  Your cursor will move to the next line allowing you to 
add an additional number.  You can continue to add as many numbers as you wish. 

3. In this example, our filter will return the three work orders numbered 17-000002, 17-000213, 
and 17-000751. 

 

4. Click GO to view the filtered set.   

 

Changing Filter Modes 
You can switch from Advanced to Standard filter mode and vice/versa.  If you are in Advanced mode, 

click the Standard button  to switch to Standard filter mode.  If you are in Standard 

filter mode, click the Advanced button  to switch to Advanced filter mode. 
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Reports 
Reports are a convenient way to view and organize data.  The desktop application contains a 
set of pre-defined reports in each module.  These reports can be modified using Crystal 
Reports™ software.  You can also create your own custom reports using Crystal Reports.  The 

following example is from the Work Orders module; however, these same steps apply in all other 
modules. 

A supervisor may need a report documenting which work orders have been worked on by each 
employee.  Our system contains a pre-defined report with just this information (the Employee Usage 
Detail report). 

1. To access the report, click  on the module toolbar. 

2. The names of all pre-defined reports are listed in the Reports dialog box.  Scroll down to find 
the report you are looking for.   

3. The Report Description box at the bottom of the screen will display a brief summary of the 
highlighted report. 

4. You may view, print, or export the report.   
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Report Filter 

Note the Report Filter box in the upper-right corner.  This feature allows you to choose which records 
will be included in the report.   

 

 

1. If you select “This Record Only”, the report will only include the information on the current 
record. 

2. If you select “Current Filter”, the report will include all records in the current filtered set.  

3. If you select “All Records”, the report will include all records in the module. 

 

Quick Reports 
You may have some reports that are used more frequently than others.  You can save these reports as 
“Quick Reports”.  This feature allows you to select and generate a report quickly, without having to 
open the entire Report List.  Quick reports are Lucity user ID specific; therefore, the Quick Report list 
will display only the reports you have saved. 

1. Click  on the module toolbar to open the report list. 

2. Right click on the report you wish to save as a “Quick Report” (default report). 
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3. Select Add to Quick Reports, with the option to save it on this record only, the filtered data 
set, or the all the records. 

 

 

4. Once a report is saved as a Quick Report, a pointing hand  will appear in front of the 
report name.   

 

 

Quick Reports will also appear in the list when you click the drop-down arrow beside the 
toolbar button. 
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Browse 
The Browse feature is used for reporting on-demand.  It allows you to quickly generate a 
report in table format.  The following example is from the Work Orders module; however, 
these same steps apply in all other modules. 

1. To access the Browse function, click  on the module toolbar. 
2. Using the Browse dialog box, you can select a series of fields from the grid on the left and add 

them to the grid on the right.  This allows you to build a report for all of your records showing 
only the information you are interested in seeing.   

3. Highlight a field in the left-hand grid. 

4. Click the  button to move it to the right-hand grid. 
5. Continue adding additional fields as necessary. 

 

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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Browse Report 

Once you have selected the fields for your Browse, click  to view the Browse report. 

 

 

 

In the example above, we’ve selected Work Order #, Problem, Problem Text, Cause, and Cause Text.  
As you can see, the Browse report displays only the selected information. 

 

Saving a Browse 

 

If this is a Browse report you would like to use 
frequently, you can save it to your Browse list. 

1. Click the  button. 

2. Enter a name for the Browse in the field 
provided. 

 Here, we’ve named the Browse 
“Problem/Cause”. 

3. Once the Browse has been saved, the name will 
appear in the grid at the bottom left-hand corner 
of the dialog. 
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Quick Browse 

 

After saving a Browse, you can access it through 
the Quick Browse list in the menu the next time 
the module is opened.  All Quick Browses appear 
in the list when you click the drop-down arrow 
beside the toolbar button. 

 

 

 

 

 

 

Document Control 
The document control feature allows you to add or delete documents, videos, images, and URLs 
to/from the record that you are on.  For example, users may want to attach a copy of an email 
to a customer record or they may attach a digital picture to an inspection record. 

Note:  It is important to remember that when adding documents using the desktop 
application, the document is only linked to the asset in Lucity.  If the document is deleted 
from your computer, it will no longer be accessible from the Lucity system.  In addition, if the 
document is on your computer and not available to the network, other users will see that it is 
attached, but will not be able to view it.  The web application allows uploading of documents 
to a document server that can be accessed by all users. 

 

 

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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To add a document, do the following: 

1. Click the Add button and fill out the dialog that appears: 

 

2. For document type files, browse to the file location by clicking the  button.   

3. Write a brief description of the document. 

 

4. For links to web pages, check the “Web Page” checkbox.  The File Path will be enabled allowing 
you to type the web address 
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5. Click Save to save changes. 

6. To access the saved documents or web URLs, click the Document Control button again.  

 

7. If the record contains documents, then this button will also be enabled:  .  Clicking on that 
button will enable you to have this document dialog open all the time for quick access to the saved 
files and URLs:   

 

You can double click on each item to open them from this dialog. 
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Relationship Button 
The Relationship button  is available to move 
quickly from one related record to another.  The 
Lucity systems rely on the integration of modules to 
efficiently record and analyze data. For example, the 
Hydrant Inventory module stores the Valve associated 
with a record.  It also shows stores information about 
its inspections.  The hydrant, valve, and inspections 
are related.  The Relationship Button displays any 
relationships of the current record to records in other 
modules. Next to each relationship name is a count of 
the number of related records.  Here’s a picture of 
some relationships to a Hydrant Inventory record: 

 

Double-clicking on one of the relationships will open the related record(s) in the other module. 

Create Work Order  
The Create Work order Button allows users to create new work order records directly from 
assets, inspections or work requests.  This tool on the desktop can either create a work 
order(s) for the current record or the entire filterset.  It can also create a work order based on 

a work order template.  When you click the Work Order button, a dialog similar to the following will 
appear that is from the Hydrant Inventory module and lists several existing templates: 

 

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________ 
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Toolkit 
Some modules have a Toolkit button that has provides users with functions designed for 
specifically that module.  When the dialog opens, you can select a tool that you wish to 
execute.  For example, the Work Order module has this toolkit: 

 

 

Sometimes, another dialog will appear after 
selecting a tool that requests more information.  For 
example, the “Change Crew for Filterset” toolkit 
will show a dialog similar to the following that 
allows you to select a new crew: 

 

The help file is a good resource for providing 
detailed information about the toolkits. 

 

 

 

Customizing Toolbars 
The desktop allows users to select toolbars to display and customize.  This allows them to remove 
modules that they don't use, or arrange them to match their work flow. 

The display a toolbar, select one or more toolbars in the View menu: 

 



Basic Desktop Functionality  39 

After selecting the toolbar, it will first display at the top of the desktop.  It can be moved to a 
different location on the screen by clicking on the bar at the far left end and dragging it to a new 
position: 

 

To customize the toolbar, right-click on it and select “Customize Toolbar”: 

 

Module buttons can be added, removed, moved up/down, and separated by a Separator by using the 
buttons in the Customize Toolbar dialog: 

 

 

 

 

 

 

NOTES:__________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________

_________________________________________________________________________________________ 

_________________________________________________________________________________________ 
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Extra Information 

Accessing Help Files 
The Lucity help files are a very useful tool for finding out more information on any topic within the 
Lucity system.  The help file requires an internet connection.   

When you are in a specific module, if you click on the Help button , the help file for that 
module will open.   

To access the full desktop help file, you can go to the main Help menu of the desktop and select “Help 
Topics”.  The desktop help file will open.  You can also access all Lucity help file topics by selecting 
the “Lucity Help Portal and Search” from the Help menu.  The Lucity Help Portal contains helpful 
information about all Lucity applications.   

 

You can run custom searches using any search criteria. For example, to find information about “Work 
Orders” on the desktop, click on the Lucity Desktop manual, type in “Work Orders” in the search field 
and click the magnifying glass to search for the related help topics.  You can click the links on the left 
side to view a topic related to Work Orders: 
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You can also drill down on the Contents menu to find detailed information on a specific topic or 
module: 

 

 

Receiving Help and Asking for Information 
You can quickly send an email to ask for help or information by using the “Email Lucity” options from 
the Help menu: 

 

 

You can also access the Lucity Support Center or start a remote Support Session by selecting the 
“Lucity on the Web” options available from the Help menu: 
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